
1 
 

Successfully Selling 

Printables on Etsy: 

How to Make and 

Market Downloadable 

Art Even if You're Not 

a Pro 
 

 
 

 

Monique Chandler 



2 
 

Contents 

INTRODUCTION ............................................................................................................................................. 3 

My Personal Passive Income Goldmine on Etsy ........................................................................................... 3 

The Secret to Your Success Rests in These Two Rules .................................................................................. 6 

Sell This = Make Steady Passive Income ....................................................................................................... 9 

How to Come Up With 100 Printable Ideas in 60 Minutes or Less ............................................................. 12 

Do This, Not That: 5 Artistic Guidelines That’ll Keep You Sane and Constantly Selling .............................. 17 

How to Set Up Illustrator for Creating Printables ....................................................................................... 24 

How to Create Complicated Art Easily ........................................................................................................ 27 

One More Thing About Clipping Masks… ................................................................................................... 51 

Creating a Quote Print ................................................................................................................................ 52 

Listing Your Images on Etsy ......................................................................................................................... 63 

9 Things You Must Include in Your Etsy Description ................................................................................... 66 

Marketing Your Printables on Etsy ............................................................................................................. 68 

Must See Tutorials ...................................................................................................................................... 73 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



3 
 

INTRODUCTION 
 

I‟m a strong believer in passive income.  

 

I‟m an even stronger believer in having multiple sources of passive income. And while 

many internet marketers take the ebook or membership site route for generating passive 

income, I‟ve fallen head-over-heels in love with Etsy.  

 

Etsy has 54 million registered users. From that you have 19.8 million active buyers and 

1.4 million active sellers. And while most of those sellers specialize in handcrafted one-

of-a-kind goodies, there are ways to build a passive income empire on Etsy without the 

one-of-a-kind goodies.  

 

Yes, Etsy and passive income do go hand-in-hand, if you know exactly what to sell. And 

that‟s what this report is all about.  

 

Over the past seven years, I‟ve launched 7 different Etsy stores. I currently run two Etsy 

shops, both based on very specific formulas that give me as much passive income as 

possible.  

 

In this report I‟ll talk about the easiest one to start. In an upcoming report I‟ll explain a 

second method I use which involves a little bit creating, but requires less creative ability. 

(This upcoming report has nothing to do with art.) Stay tuned for that one! 

My Personal Passive Income Goldmine on Etsy 
 

I started selling art on Etsy 6 years ago. I believe it was the second shop I launched.  

 

I didn‟t consider myself an artist at the time. I am (and always have been) a hungry 

entrepreneur. If there was easy money to be made, I was always ready to learn how to do 

it, even if it meant stepping outside my comfort zone.  

 

Art was a good fit for me because most artists don‟t have the greatest marketing and 

business sense. I already had the business wisdom lined up, so it was just a matter of 

getting good enough to create salable art. My intent was never to become the next 

Picasso. I just wanted to learn enough to get people to buy the art I created. 

 

Instead of taking the traditional artist‟s route with pencils and paints and canvases and 

pricey boars hair paint brushes, I learned my way around Adobe Illustrator.  
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Illustrator is a software program that‟s similar to Photoshop, except it‟s better for 

creating illustrations. You don‟t need to know every nook and cranny of Illustrator in 

order to create art with it. (Later in this report, I‟ll talk about what you need to learn and 

why you need to learn it. I‟ll even show you how to create what appears to be a complex 

piece of art.) 

 

With Illustrator in hand, you can create as much digital art as you want without having 

to pay for materials.  

 

Mistakes? No problem. Delete the problem area and start over.  

 

Need a color change? No problem. You‟ve got a gazillion colors at your fingertips.  

 

And at only $20-$30 a month, the price for Illustrator is definitely right. Once you‟ve 

got a system going, you can crank out 3-10+ pieces of art every day until your store is 

full enough.  

 

Now back when I first started, I had a great big Epsom printer and I would print out my 

artwork and ship it to my customers. Today I don‟t do that. Today, I create the art on 

Illustrator and sell it as printable artwork on Etsy.  

 

This means the customer is buying a digital file and they will print the art out 

themselves.  

 

And while this printable artwork method means I earn $8 less in profits, it also means: 

 

 I don’t have to print anything. Premium archival paper and ink costs could 

get pretty hefty, especially when you‟re just learning your way around Illustrator 

and you want to see your work printed out.  

 

 I don’t need cardboard sleeves, plastic bags and rigid envelopes to 

ship the art work.  

 

 I don’t have to go package everything up and take it to the post office.  

 

 I can be ANYWHERE in the world, create my printable art and sell it 

within minutes of deciding that it looks great. I don‟t need a printer and 

all the extra material to make a few bucks.  
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I think of my printable artwork as an ebook. Create it once, profit from it forever and 

ever. It‟s a great passive income generator, with far less competition than traditional 

ebooks. 

 

So now that you know the secret, let me tell you how I create art without any formal 

training as an artist.  
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The Secret to Your Success Rests in These Two Rules 
 

I have a theory about selling printable art on Etsy, and you‟ll see me repeat it several 

times throughout this report. My theory is only two words long, but it‟s going to save 

you a lot of time in this new venture. 

 

Those two words?  

 

RULE #1 - Simplicity sells. 

No matter what type of printable art you choose to make, the best thing you can do for 

yourself is to keep it simple and clean.  

 

Yes, you‟ll be competing against seasoned artists and graphic designers who have all 

kinds of drawing and artistic skills. Yes, their pieces will appear more technically 

complex when compared to yours. But don‟t allow that to scare you out of this venture. 

There‟s actually a pretty huge market for simple artwork.  

 

For example, when Brianna buys art on Etsy, you can be assured it‟s probably not the 

only piece on her wall. Brianna might have several paintings and prints on her wall. She 

might have some big wall collage of varying sized pieces - (an idea she got from 

Pinterest). Some of the artwork occupying her wall space will be stuff she‟s collected 

from serious artists. And some of it will be simple and clean… the exact type I‟ll be 

teaching you how to create.  

 

Josephine just moved from Georgia to the concrete jungle known as New York City. Her 

600 square foot studio screams, “MODERN!” Josephine is looking for simple, clean 

artwork. Yup… the exact type I‟ll be teaching you how to make.  

 

Flora just relocated to a condo in Sunny Isles Beach, Florida. Big windows, white leather 

sofa, and yes, simple artwork.  

 

I can tell you these stories because they were all customers of mine. They loved art... all 

kinds of art. If you create what people want, they‟ll buy it.  

 

Art buyers want watercolors. They want acrylic and oil paintings. They want pencil 

drawings. They want big. They want little. They want detailed and they want clean lines. 

Abstract and realistic. You name it, there‟s probably a market for it.  

 

Because you‟re probably not in the art field, it‟s best that you take the path of least 

resistance and keep it simple.  
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Now let‟s dig a little deeper, because it‟s not just a matter of putting up a quote print 

made from a basic font and waiting for the sales to pour in.  

 

If you want to start making money right away, you need to make sure your simple 

designs look modern.  

 

RULE #2 - The Trend IS Your Friend 

I once had the option of buying a condo that had an ancient looking baby blue bathtub 

with matching tile throughout the entire bathroom, or one that had a marble tiled 

bathroom, with a brand new extra long bathtub.  

 

Even though the unit with ancient looking bathroom had one more bedroom, I opted for 

the unit with the better looking bathroom.  

 

The trend is your friend when you want to rent out a unit immediately and for the 

highest amount possible. In this case, I was able to get $300 more a month than I would 

have if I‟d purchased the unit with the dated looking bathroom. 

 

Trends win. Not always. But most of the time... especially when it comes to printable art.  

 

I‟m going to show you an example of the trend being a friend so that you‟ll understand 

the profit power of modern looking art.  

 

First have a look at Baby Art Prints. They sell $5-$20 printable artwork and average 5-

10 sales a day with 1,110+ listings. Their stuff is cute, but I wouldn‟t call it trendy.  

 

Now have a look at Melime Baby Art. They sell $5-$8 printable artwork and average 3-5 

sales a day with 125 listings. Their work is more definitely more trendy.  

 

The geographic triangles - trendy. The gold foil look in some of the design elements - 

trendy. The quote, "Wild and Free" - trendy.  

 

On average, Melime sells fewer prints than Baby Art Prints. But at the end of the day, 

Melime put in FAR less work and they only spent $25 to list their inventory versus $220 

with Baby Art Prints.  

 

Now let‟s take it a step further and compare those two stores to Mini Learners.  

 

They sell their printables for $5.83. They have 215+ listings and average 6-10 sales a 

day.  

 

https://www.etsy.com/shop/nataeradownload
https://www.etsy.com/shop/MelimeBabyArt
https://www.etsy.com/shop/MiniLearners
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Mini Learners embraced my two favorite rules. They keep their designs simple. And they 

use on trend elements in their work.  

 

Plus they also use two other tips I‟ll be sharing in the next section. Their color scheme is 

very small (mainly black and white), and they‟ve limited their font selection to what 

looks like two different styles.  

 

So how do you know what‟s on trend?  

 

Start here to get your feet wet: 9 Graphic Design Trends for 2015   

 

Next, proceed to your local library and scan through the latest home decorating 

magazines – especially the DIY decorating mags. I‟ve „borrowed‟ plenty of font and color 

ideas from stuff I‟ve seen in other publications. And customers love it because they‟re 

getting similar designs they‟ve seen elsewhere at a significantly lower price. 

 

Then, I use the following graphic design element sites as my ongoing barometer for 

what‟s hot:  

 

Creative Market Popular Fonts 

If you‟re going to do quotes, this is a great place to see what fonts are popular right now. 

However (and this is important) please keep in mind that Creative Market has a Simple 

License that forbids using their fonts in printable artwork. It states, "Cannot be used in 

a product offered for sale where the item contributes to the core value of the product 

being sold." 

 

Bummer, I know. But, you can use Creative Market as a point of reference to see what‟s 

hot, and then you can go to other font sites (listed on page 19) that permit commercial 

usage. 

 

Hype for Type Bestsellers 

They have a Merchandise License for each font selection. This means you may use these 

fonts in your printable artwork.  

 

Creative Market Popular Add-Ons 

They have the popular gold foil look here. They have a letterpress style library which 

gives your text that retro/vintage look. There are tons of watercolor brushes. This page 

will give you a general idea of what‟s hot as far as design elements. But again, their 

Simple License forbids using these add-ons in printable artwork. Only use it as a point-

of-reference. I will show you where to find graphic design elements in the next section.  

http://www.digitalinformationworld.com/2015/01/graphic-design-trends-infographic.html
https://creativemarket.com/popular/fonts
http://www.hypefortype.com/browse-fonts/best-sellers.html
https://creativemarket.com/popular/add-ons
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Sell This = Make Steady Passive Income  
 

Simple and trendy. Trendy and simple. Those are the basic rules.  

 

Now the next question is: what should you sell that falls within the parameters of those 

two rules? Well as an old timer here, I can tell you that the rotation rarely changes 

outside of the items you see below. People buy these types of prints year after year, 

without fail.  

 

As long as you change the look of your work to match with the trends, you‟ll do just fine. 

(Please re-read that last sentence when sales get slow.) 

 

1) Quotes, quotes and more quotes 

We‟re talking Bible verses, quotes about cities, inspirational messages, quotes you make 

up, words and even numbers.  

 

If you‟re going to do quotes and word prints, I suggest you come up with a theme. Don‟t 

do Bible verses and sports quotes in one Etsy shop... either do one or the other. Then 

when you make the categories in your Etsy store, you can further segment the theme.  

 

Going back to the sports quotes example (which is great idea that really hasn‟t been 

done-to-death on Etsy), you can have baseball quotes, basketball quotes, soccer quotes 

(or football, depending on what side of the pond you‟re on), tennis quotes and so on.  

 

For Bible verses, you can break it down by verses for family unity, verses for strength, 

verses for marriage, verses for healing, etc.  

 

Here are several more theme quote ideas you can build your shop around:  

 Quotes about specific occupations (nurse quotes, teacher quotes) 

 Quotes about friendship 

 Quotes for parents/grandparents 

 Holiday quotes 

 Hobby quotes (gardening, golf) 

 Foodie quotes 

 Fitness quotes 

 Spiritual quotes 

 Lines from popular songs 

 Lines from popular television shows 
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2) Animals 

Dog and cat prints tend to do well on Etsy, especially if you have a separate print for 

each breed. If you can combine an image of a dog breed with a cute quote, even better.  

 

For instance, a silhouette of a poodle and a quote like, “Home is where my poodle is.” 

And then you can have a silhouette of shih tzu and the same quote, “Home is where my 

shih tzu is.”  

 

Other animals that do well on Etsy include: deer (with or without antlers), birds, koalas, 

horses, foxes, whales and butterflies.  

 

The animals that you include in your print don‟t have to look realistic (as in hand 

drawn). If you know your way around the Adobe Illustrator pen tool, you‟ll be able to 

create a silhouette of a specific animal. This is even better than clip art, because now you 

have something that is YOUR OWN personal image. Using the pen tool means you‟ll 

even be able to add in small details, like color on a tummy.  

 

(In a later section I‟ll be showing you a print I did several years ago where I used the pen 

tool to create two different silhouettes.) 

 

3) Nursery/Children’s Art 

This is where I got my feet wet when I first started selling prints online. It‟s a very 

lucrative market because your potential customer base is always expanding. (Hurray for 

baby making and tons of Etsy-shopping moms!) 

 

When it comes to children‟s art work, you‟ll usually see more images– versus quote 

prints. Things like:  

 

 birds 

 bunny rabbits 

 bears 

 elephants 

 giraffes 

 zebras 

 pandas 

 flowers 

 hearts 

 rainbows 

 clouds  

 balloons 
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 robots  

 rocket ships 

 airplanes 

 sailboats 

 lighthouses  

 tents and campfires 

 bicycles 

 dump trucks 

 hot air balloons  

 cute sea creatures (dolphins, whales, lobsters, octopus, seahorse)  

 unicorns and dragons 

 dinosaurs 

 

Outside of pictures, buyers also like decorated monogram letters, short quotes 

(“Adventure Awaits Little One”), the alphabet and numbers.  

 

4) Location Pride 

The most basic print idea is the silhouette of a state. Several sellers are making the trend 

their friend, by making the silhouette appear like it‟s been painted with gold leaf. (You 

can easily do this with a gold foil texture and Illustrator‟s clipping mask, which I‟ll talk 

about in the next section.) 

 

You can do silhouettes of skylines. Or even the silhouette of a major landmark with a 

quote.  

 

You may opt to do just quote prints about cities - "New York, New York, What a 

wonderful town." 

 

Maps made into prints for a specific city have also done well, especially if you can find a 

few in the public domain.  

 

For location loving geeks, how about latitude and longitude incorporated into your 

print? 

 

For the sports lovers with locational pride, you can offer a quote about local teams.  

 

Obviously there are lots of ways to tackle this niche.  
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How to Come Up With 100 Printable Ideas in 60 
Minutes or Less 
 

You will need at least 100 printables in your shop to get orders on a regular basis. I say 

“at least,” because the more, the better. Once you reach 200, and follow my marketing 

tactics (presented later) you should be getting at least a few orders a day.  

 

Many printable super sellers have 200-700 listings, but not all of those prints are 

different. In some shops you‟ll notice that a seller will have the same print listed 

multiple times with a different color scheme. This is perfectly acceptable, though I‟m old 

school in that I like having an excess of ideas ready to go at any given time.  

 

In your Etsy storefront, you‟re encouraged to come up with Shop Sections for your 

products. If you can come up with 10 Shop Sections, and develop 10 printable ideas for 

each category, you‟ve got 100 ideas to start with.  

 

Likewise, you can develop 5 Shop Sections to start, with 20 printable ideas in each one. 

Later on when you start seeing which printables sell best, you can add Shop Sections 

based on your bestsellers.  

 

For instance, if you have an Outdoor Sports section, and you notice that you‟re selling a 

ton of soccer printables, you can add a different section just for soccer quotes. This is 

always a good search engine optimization strategy.  

 

Okay, so suppose you want to do quote prints for children. You decide to make „the great 

outdoors‟ the focus of your shop. Maybe you name your shop something like, Get 

Outside Child. 

 

First, you‟ll come up with 5-10 different categories that relate to the great outdoors. (I‟m 

literally just pulling these out of thin air as I type this… you can probably do better.) 

 

1. Camping  

2. Nature 

3. Fishing 

4. Seasons 

5. Mountains 

6. Adventure 

7. Biking 

8. Play 

9. Swimming 
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10. Outdoor Sports 

 

Then for each category, you‟re going to do the following Google searches: 

“camping words” 

“camping quotes” 

 

As you look through the different words and quotes, just start writing down short 

phrases that pop into your mind. They don‟t have to be super poetic. It‟s usually the 

quirkiest little saying that sells the most, so don‟t judge yourself while doing this. 

(Besides that, you‟re not printing anything, so you can afford to let your imagination go 

wild.) 

 

You may also want to borrow my little cheat sheet of universal quote phrases. Insert a 

word/phrase into the blank line and you have a ready-to-go quote. You‟ll notice that I‟ve 

used some of these in the Get Outside Child brainstorm session. 

 

o I believe in __________ 

o I love __________ 

o Future __________ 

o __________+__________= Yay! 

o __________ Here I Come 

o Life is always better with__________ 

o All you need is __________ 

o __________ and smile 

o Happiness is __________ 

o Sometimes you just have to __________ 

o You can‟t __________ if you keep on __________ 

o I always find my smile at/when __________ 

o You are __________ 

o Have __________, will __________ 

o __________ makes everything better 

o Life begins when __________ 

o It‟s a good day to __________ 

o You‟ll never __________ if you don‟t __________ 

o Hurray for __________! 

o Long live __________ 

o Find your soul at __________ 

o True Story: __________ 
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Even though you might only be doing quotes for this store, it‟s also a good idea to come 

up with a quick image idea for at least some of your printables, just in case you want to 

alternate between quotes and images.  

 

Based on what I just told you, here‟s what I came up with for Get Outside Child.  

 

Camping 

I love camping  (Image: tent) 

I love sleeping under the stars (Image: stars) 

I love tents (Image: tent) 

I love campfires (Image: campfire) 

I love campfire s‟mores (Image: s‟more on a stick) 

Marshmallows + Campfire = Yay! (Image: campfire and marshmallow on a stick) 

Have backpack, will hike (Image: backpack) 

Squirrel Whisperer (Image: squirrel) 

Future Ranger  

Future Rangerette 

 

Nature 

I love nature 

Nature Lover (Image: heart over nature background) 

I love trees (Image: tree) 

Tree Hugger (Image: tree) 

I love butterflies (Image: butterfly) 

Love Mother Earth 

Daughter of Mother Nature 

Son of Mother Nature 

I Believe in Mother Nature 

Roll in the Grass (Image: grass) 

Smell a Flower (Image: flower) 

Wild Flower 

 

Fishing 

I love fishing 

Baby Angler Coming Through 

The fish are calling 

I dream of fishing 

Future Bassmaster 

Daddy + Fishing = Love 

I‟d Rather be Fishing with Dad 

Salmon Whisperer 
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Bass Whisperer 

Catfish Whisperer 

 

Seasons 

I love the sun 

I love the moon 

Moon Baby 

I love the stars 

Wish upon a star… 

I love the clouds 

I love snow 

I love sledding 

Tropical baby 

 

Mountains  

I love mountains 

Mt. Everest Here I Come! 

Mountains are Calling Little One 

Climb Every Mountain 

Climb Into the Clouds 

Climb High 

Never Be Afraid to Go Higher 

Take a Hike, Kid! 

We Climb 

 

Adventure 

Adventure Awaits Wee One 

Explore! 

Explore Far and Wide 

Outdoorsy Baby 

I love a good adventure 

Life is a Grand Adventure 

Live Learn Explore 

I was born to explore 

Adventure Girl 

Adventure Boy 

 

Biking 

I love my bike 

Backseat Rider 

Tricycles Rock! 
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Epic Bike Baby 

Have Helmet, Will Ride 

Happiness is Riding My Bike 

I Want to Ride My Bicycle 

My Other Stroller is a Mountain Bike 

 

Play 

I love playgrounds 

I love swings 

I love sliding boards 

Teeter-totters rock! 

Play all day, sleep all night 

Play everyday 

Outside – Everyday - Let‟s Go 

Let‟s Play 

Did someone say, “Playground?”  

The sandbox is calling 

 

Swimming 

Beach baby 

Bikini Baby 

I love the beach 

Builder of Sand Castles 

Swimming, Swimming 

Water Baby 

The ocean awaits little one 

Sea - Sand - Swimming  

Let‟s go swimming 

There‟s never a bad day to feel the sand between your toes 

 

Outdoor Sports 

I love baseball 

I love football 

I love soccer 

I love golf 

I love tennis 

Future baseball pro 

Future quarterback 

Take me out to the ball game 

Soccer Baby 

Daddy‟s Little Soccer Star 
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Do This, Not That: 5 Artistic Guidelines That’ll Keep You 
Sane and Constantly Selling 
 

I‟m not going to make you an Adobe Illustrator expert in this short report. Illustrator is 

a meaty program with lots of doo-dads to go through.  

 

What I am going to do is show you just enough about Adobe Illustrator so that even if 

you‟ve never seen it before you‟ll be able to go in, create printable art, and make it look 

like a fairly skilled professional did it. You‟ll see exactly which toolbars, windows and 

palettes to use. 

 

If you stick with what I‟m going to tell you, and learn about the specific tools I talk 

about, you‟ll be fine. I‟m including links to lots of tutorials that have helped me master 

these tools over the years.  

 

1) Keep your color schemes simple 

Why? Because simplicity sells, of course.   

 

If you check out the catalogs of Etsy‟s printable art super sellers, you‟ll notice that many 

of their works are 2-3 colors at the most. Earning a decent profit is sometimes as simple 

as black and white (pun intended!). 

 

For example, a pink background with white lettering, a white background with gold 

lettering, or a navy blue background with a white image.  

 

If you want to have more than one color for single piece of art, you can always add color 

options to your listing. For example, if you‟re selling a quote print, you can have a black 

background, blue background, pink background, orange background, etc. You can 

provide all the color options under a single 20 cent listing and your customer can choose 

the colored background they want.  

 

If you want to have more than two colors, and you‟re not exactly a color matching 

expert, have a look at the Material Palette. You choose two colors from the 19 listed and 

the app automatically creates a color palette for you. It‟s a very simple way to create a 

quick color scheme.  

 

There‟s also a wide variety of palettes at ColourLovers.com. I also love Design Seeds 

search, which allows you to search by season, flora, edible hues, creatures, rustic, 

market hues and so on.  

 

http://www.materialpalette.com/
http://www.colourlovers.com/palettes
http://design-seeds.com/
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As a non-artist, I don‟t do any type of shading. If I have a ball on a page, that ball is a 

single color. Don‟t ever feel like you have to go overboard with how you color the 

objects. You‟ll lose your mind if you try too hard.  

 

Keep your work simple and it‟ll sell. Many Etsy shops have successfully proven this 

point, time and time again.  

 

2) Build a small font library 

While there are thousands of fonts to choose from, it‟s important (for time‟s sake) that 

you find several you really love and stick to those.  

 

I like to have 2-3 sans serif fonts, 2-3 cursive fonts, 2-3 serif fonts, 2-3 handwritten 

fonts, and an outline font.  

 

From that selection, I have at least one group that matches -- like a serif font and a sans 

serif font. Or a cursive font and a sans serif font.  

 

Everybody has their favorite fonts, but I do suggest you keep trendy looking fonts in 

your arsenal. If the fonts you use are modern looking, you‟ll bump up your trendy points 

and have a greater opportunity to make more sales.  

 

DO NOT pick commonly used fonts like Arial, Times New Roman or Comic Sans (which 

is the WORST possible font you can ever pick in your entire life).  

 

While the average person may not be able to look at a print and say, “Ewwww, why are 

they using Arial???” something will register in their sub-conscious that it looks too 

normal. You want simple, but not normal. You don‟t get paid well for normal. You get 

paid when you make the trend your friend.  

 

I‟ve included several font pairing examples below.  Many can be used for commercial 

projects, but you‟ll always want to double check to make sure. It‟s no fun paying for a 

font only to realize that the license forbids commercial use.  

 

Fontaholic - Beautiful Font Combos 

 

10 Favorite Handwritten Font Combos 

 

14 Fresh Fonts for Spring 

 

Font designer Kimberly Geswein has an excellent group of tutorials to help match fonts 

quickly and easily.  

http://pinkreptiledesigns.blogspot.com/2014/02/fontaholic-beautiful-font-combos.html
http://www.yellowblissroad.com/favorite-font-combos-handwritten-fonts/
http://simpleasthatblog.com/2014/03/14-fresh-fonts-for-spring.html
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Font Pairing Guide #1 

 

Font Pairing Guide #2 

 

Font Pairing Guide #3 

 

Font Pairing Guide #4 

 

Font Pairing Guide #5 

 

Font Pairing Guide #6 

 

Font Pairing Guide #7 

 

Canva also has a great tutorial for budding font pairers: 

 

The Ultimate Guide to Font Pairing - Part 1 

 

The Ultimate Guide to Font Pairing - Part 2 

 

Plus, as I promised, here are several font sellers that allow commercial usage.  

 

Inky Deals 

All of their deals typically come with commercial usage licenses. You‟ll definitely have to 

search through the deals to find the fonts that‟ll work for your project. 

 

Hype for Type 

100+ free fonts that can be used for commercial projects.  

 

10 MORE FREE TYPEFACES FOR COMMERCIAL AND PERSONAL USE 

These are great for quote prints. 

 

12 Free Script Fonts 

Also great for quote prints.  

 

Font Squirrel 

All of the fonts listed here are free and have commercial usage licenses which permit you 

to use them in your printable artwork.  

 

 

http://www.kimberlygeswein.com/2015/02/25/font-pairing-guide-1/
http://www.kimberlygeswein.com/2015/02/26/font-pairing-guide-2/
http://www.kimberlygeswein.com/2015/02/27/font-pairing-guide-3/
http://www.kimberlygeswein.com/2015/03/02/font-pairing-guide-4/
http://www.kimberlygeswein.com/2015/03/03/font-pairing-guide-5/
http://www.kimberlygeswein.com/2015/03/04/font-pairing-guide-6/
http://www.kimberlygeswein.com/2015/03/05/font-pairing-guide-7/
https://designschool.canva.com/blog/the-ultimate-guide-to-font-pairing/
https://designschool.canva.com/blog/font-pairing-like-a-pro-part-two/
https://www.inkydeals.com/?s=font&site_section=active-deals
http://www.hypefortype.com/browse-fonts/free.html/
http://www.shemakesahome.com/2013/10/10-more-commercial-fonts-to-use-for-free.html
http://dinosaurstew.com/twelve-free-script-fonts/
http://www.fontsquirrel.com/
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3) Make friends with the pen. 

As a non-artist, one of the best things you can do to ramp up your design skills super 

fast is to learn how to use the pen tool in Adobe Illustrator.  

 

With the pen tool, you can take any image, trace an outline of it, color the outline in (or 

use the silhouette), and place the new image in your artwork. This is how I create my 

own personal clipart library.  

 

I won‟t go over all the logistics of using the pen tool in this report, as there are entire 

books written about it. But there are several great tutorials, including:  

 

Become a Master of the Pen Tool in Under 30 Minutes 

 

Day 5: Drawing with Pen Tool 

 

VIDEO: Tracing with the Pen Tool in Adobe Illustrator 

 

VIDEO: How To Use The Pen Tool in Adobe Illustrator, Photoshop and InDesign CS6 

 

4) When in doubt, use SCI to lay it out. 

Don‟t ever feel compelled to fill every centimeter of space on your page. Plenty of sellers 

have nothing but a single image in the center of the page, and they do perfectly fine.  

 

I call these prints Single Centered Images or SCI for short.  

 

Take Fancy Digitals, for example. They have 265+ printables in their store. The majority 

are an image in the center of the page. They sell each printable for $5 and they average 

2-4 sales a day. 

 

And then there‟s LineLight. They have 190+ printables they sell for $5, and they also 

average 2-4 sales a day. Many of their prints are SCI.  

 

Best of all, SCI isn‟t just for images. You can lay your quotes out in SCI fashion as well.  

 

Inspirational Quote has an obvious (and profitable) love for SCI. They‟ve got 775+ 

printable quote posters for $5. As far as I can see, they‟re all done in SCI. They average 

4-8 sales a day.  

 

Obviously they‟re not getting rich selling these single images. But once those single 

images are created, it‟s all passive income. Hit the relist button and go spend your gas 

money, type of thing.  

http://psd.fanextra.com/tutorials/become-a-master-of-the-pen-tool-in-under-30-minutes/
http://www.vectordiary.com/illustrator/drawing-with-pen-tool/
https://www.youtube.com/watch?v=s1Rx818ZEko
http://tv.adobe.com/watch/creative-suite-podcast-designers/how-to-use-the-pen-tool-in-adobe-illustrator-photoshop-and-indesign-cs6/
https://www.etsy.com/shop/FancyDigitals
https://www.etsy.com/shop/LineLightStore
https://www.etsy.com/shop/InspirationalQuote
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 5) Use elements as the secret sauce. 

Swirls. 

 

Striped lines. 

 

Wood texture. 

 

Clip art. 

 

Glitter!!!!!  

 

These items are all in the realm of graphic design elements, and they‟re an easy way to 

add some trend to your printables. In most cases it‟s just a matter of opening the file in 

Illustrator and adding the element to your printable design. No drawing skills necessary. 

Nor will you have to use the pen tool.  

 

I‟m going to show you how other artists have used graphic design elements in their work 

so you‟ll understand how to use them in your own printable art.  

 

 You Are My Sunshine has a decorative element above and below the text.  

(Similar elements can be found at Vectorian.net.)  

 

 The Love print is centered on the page against a chevron background.  

(A similar chevron background can be found at the Rustic Digital Paper shop.)  

 

 Love Lives Here is centered in between a laurel wreath.  

(A similar laurel wreath can be found at Vecteezy, where a premium membership 

is only $14 a month... and it‟s royalty free.)  

 

 This Jane Austen Quote is centered on an ink splotch.  

(A similar ink splotch can be found at Vecteezy. The premium membership is $14 

a month and you get royalty free downloads.)  

 

 Life is a Beautiful Ride has a bike.  

(Pixaby is a search engine for royalty free images, including vector graphics and 

illustrations that can be used with Adobe Illustrator. Here are a bunch of bikes I 

found there.)  

 

Below, I‟ve listed several shops that feature graphic design elements you can use within 

your printables. For the Etsy shops, I‟ve linked directly to the listing for the commercial 

https://www.etsy.com/listing/203733403/quote-wall-art-print-you-are-my-sunshine?ref=shop_home_active_23
http://www.vectorian.net/free-vintage-vectors.html
https://www.etsy.com/listing/229198253/love-wall-art-chevron-print-love?ref=shop_home_active_3
https://www.etsy.com/listing/175386995/pink-and-grey-digital-paper-floral?ref=shop_home_active_2
https://www.etsy.com/listing/184728139/50-offlove-lives-here-new-home-art?ref=shop_home_active_1
http://www.vecteezy.com/ornaments/80842-hand-drawn-laurels-wreaths-vector-collection/premium
https://www.etsy.com/listing/216841483/jane-austen-print-jane-austen-poster?ref=shop_home_active_4
http://www.vecteezy.com/spills-splatters/58020-grungy-dry-paint-vector-pack/premium
https://www.etsy.com/listing/176664252/life-is-a-beautiful-ride-illustrated-art?ref=related-0
http://pixabay.com/en/photos/?q=bike&image_type=vector&cat=&order=
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license. A commercial license basically gives you the right to use someone else‟s 

elements in work you sell.  

 

While there are many more sellers on Etsy that offer commercial licenses, not all of 

them allow you to include their work in digital form. I‟ve gone through dozens of shops 

to find the ones that do. However, keep in mind that sellers can (and do) change their 

minds. So while the information listed is accurate as of the time I‟m writing this, always 

make sure you check the terms of their commercial license before you buy it.  

 

Click Designs Commercial License 

You may use their digital papers in your printable artwork if you sell 250 copies or less. 

Once you hit 250 sales, you‟ll need to purchase a commercial license for $20. 

 

Rustic Digital Paper Commercial License 

They have a $20 extended commercial license for using their clipart and digital paper.  

 

Pixel Garden Mini Commercial License 

This $14 commercial license allows you to use Pixel Garden‟s digital paper and clip art 

in products up to 300 sales.  

 

Grepic Extended License for Commercial Use 

This $20 extended license permits you to use Grepic‟s digital paper and clip art on 

merchandise for sale. 

 

My Dear Memories Extended License 

You may use their clip art and digital paper in up to 100 sales without the extended 

license. Once you hit 100 sales, you must purchase the $20 extended license.  

 

Studio Nine Digital Art Commercial Use License 

This $15.52 license can be used for both digital and physical products.  

 

Pixeled Paper Designs 

You may use any of her clip art or digital paper for commercial use IF it contributes to 

less than 60% of the total project. See the policies page for more details. 

 

Retrovectors 

They have a variety of graphic design elements that can be used in commercial projects. 

These are 100% free! 

 

 

 

https://www.etsy.com/shop/ClickDesigns?section_id=16335878&ref=shopsection_leftnav_7
https://www.etsy.com/shop/RusticDigitalPaper?section_id=14241379&ref=shopsection_leftnav_4
https://www.etsy.com/listing/220406436/mini-commercial-license-add-on-no-credit?ref=shop_home_active_1
https://www.etsy.com/listing/152703023/extended-license-for-commercial-use-add?ref=sr_gallery_42&ga_search_query=digital+paper+commercial+license&ga_order=most_relevant&ga_search_type=all&ga_view_type=gallery
https://www.etsy.com/listing/182027634/extended-commercial-license-for-digital?ref=sr_gallery_37&ga_search_query=digital+paper+commercial+license&ga_order=most_relevant&ga_search_type=all&ga_view_type=gallery
https://www.etsy.com/listing/231678473/commercial-use-license?ref=sr_gallery_22&ga_search_query=digital+paper+commercial+license&ga_order=most_relevant&ga_page=2&ga_search_type=all&ga_view_type=gallery
https://www.etsy.com/shop/PixeledPaperDesigns
https://www.etsy.com/shop/PixeledPaperDesigns/policy
http://retrovectors.com/
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InkyDeals 

They‟ve always got deals for vector files, illustrations, fonts, backgrounds and textures 

that come with commercial (also known as extended) licenses.  

 

Deal Jumbo 

To me they‟re slightly more on trend than InkyDeals. They‟ve always got some good stuff 

here with commercial licenses.  

 

Spoon Graphics Freebies 

He has some great backgrounds and textures here. He also has a $10 a month section 

with hundreds more textures and graphics. 

 

GraphicStock 

They have a free 7 day download period for new members, and all of their images are 

royalty free.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.inkydeals.com/active-deals/
http://dealjumbo.com/all-deals/
http://blog.spoongraphics.co.uk/category/freebies
http://www.graphicstock.com/
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How to Set Up Illustrator for Creating Printables 
 

I personally use Adobe Illustrator CS4, which came on a CD. Adobe no longer sells the 

actual software.  

 

Now they have the Creative Cloud (CC) version. You download the basic program onto 

your computer, and all the licensed stuff is in the cloud (online). This means you‟ll need 

a paid subscription to use anything beyond Illustrator CS6.  

 

It‟s actually cheaper to get the CC subscription than it is to buy an old software copy of 

Illustrator. Plus you automatically get all the updates with the CC subscription.  

 

However the downside of a subscription is the monthly cost. It‟s $19.99 a month, if you 

choose to go month-t0-month for a year, $239.88 if you pay for a year up front, or 

$29.99 a month if you don‟t want to lock yourself in for a year.  

 

If you‟re a student or a teacher, that price goes down to $19.99 a month, without a yearly 

contract, or $239.88 a year paid up front.  

 

You could get out your initial 100-150 printables out within the first month (or within 

the first week, depending on how well you work your way around Illustrator) -- if you 

have a list of 100-150 print ideas in a ready-to-go list. Within two months you should 

plan on having at least 150-200 printables in your shop.  

 

Setting Up a Printable Document 

When you fire up Illustrator, you‟ll see a “Create New” window. Always choose “Print 

Document.”  
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After you click on “Print Document” you‟ll be taken to a second window that allows you 

to choose your artboard (otherwise known as a canvas) options. 

 

The four most important options are:  

 

 Width and height – This is where you type in the size of the artboard you want to 

create your printable on.  

 

 Units – I‟m in the USA, so I go with inches. If you‟re in A4 land, you may want to 

go with centimeters.  

 

 Orientation – Are you going to make your design vertical or horizontal? 

 

 Raster Effect – Choose the highest resolution, which is 300 dpi.  

 

Printable sizes and file types 

If you‟re only going to offer one default size, let that be 8x10 (inches). This is the most 

commonly offered size among printable sellers. 11x14 and 16x20 are second and third in 

the lineup.  

 

A4 (8.27 x 11.70) and A3 (11.70 x 16.55) are popular sizes for those outside of the United 

States. 
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If you‟re going to offer two different sizes, I‟d say 8x10 and 11x14. You can also set up a 

separate listing for resizing your prints if a customer needs a different option. Sellers 

charge $2-$5 for this extra.  

 

Prints are typically formatted as JPEG files of the highest quality, which is 300 dpi.  

 

So when you save your file, first you‟ll save it as an AI file (Adobe Illustrator). This will 

allow you to go back in and easily change all the colors, text, pictures, etc. To do this, go 

to the “File” menu at the top of the program and go down to “Save.” By default, your file 

will save as an .AI file. 

 

Next, you‟ll save it as a JPEG file. To do this, go to the “File” menu at the top of the 

program and go down to “Save for Web & Devices.” (This part may be different 

depending on your version of Illustrator, but it‟s always something similar.) Be sure to 

change the file format to JPEG… Maximum… with the highest quality, as shown in the 

screenshot below.  
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How to Create Complicated Art Easily 
 

Whenever you‟re trying to duplicate what looks to be like a complex piece of art, 

remember that everything you see is just a layer. The only thing you have to do is create 

each layer separately and then piece it all together.  

 

This is great because it allows you to change colors, resize images and move layers at 

will. If you don‟t like a particular layer, you can easily move it out of the artboard area 

and put something else in. Nothing is set in stone with Illustrator.  

 

Remember, as long as you save your basic print as an .AI file, you‟ll be able to go back in 

and change anything. Once you‟ve made your final adjustments, you save it as a JPEG 

file. If you only save a printable as a JPEG, you‟re basically screwed because you won‟t 

be able to change anything. All the layers will be flattened together. (I know I mentioned 

this a couple pages back, but it‟s really important that you save the files two different 

ways.) 

 

Okay, so this is a print I did five years ago. (It sold very well.) It has a total of five layers. 

 

I chose this one to demo because it shows how to create and add in images, color and 

texture (over the brown deer). These are simple techniques that can be used on a variety 

of printable pieces. If you can do this, you can have a thriving printables store.  
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BOTTOM LAYER: Blue background - I just made a blue box (from the shapes toolbar) 

on the canvas.  

 

To do this, simply click on the “Shapes” toolbar on the far left hand side of the screen. If 

you click on it, hold the click, and pull the mouse a little to the right, you‟ll see a square, 

circle, rounded rectangle, polygon, star, etc. Obviously this is the toolbar you‟ll use to 

easily create different shapes.  

 

Now go over to your artboard, left click on the mouse, hold it and draw out the rectangle 

background to fill the artboard. It should now look like white on white.  
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To add the blue color to the rectangle shape you just created, click on the “Selection” 

tool, which is the dark colored arrow. (You‟ll see me refer to this one constantly.) The 

Selection tool does exactly as the name implies… it selects whatever image, shape or text 

you want. Once an object is selected, you can color it, move it, or resize it.  

 

After you‟ve click on that Selection tool, click on the rectangle you just created. If you‟ve 

selected it correctly, you should see a blue outline appear around the rectangle, as in the 

screenshot below.  

 

You‟ll notice that my rectangle is slightly bigger than the artboard. This is perfectly okay. 

When you save the file, it will only save the objects on the artboard. I like this feature 

because it allows you to experiment with all kinds of stuff off the artboard, then you can 

add what you want. When you print the document, none of the fluff outside of the 

artboard will appear.  
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With the rectangle selected, you can change the color by double clicking on the color 

palette on the far right hand side of the screen. If you double click on that little square 

I‟ve circled, the “Color Picker” will appear on the screen. You can use the Color Picker to 

choose any color you want for your objects or even text.  
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SECOND BOTTOM LAYER: Yellow sun - Half circle (also from the shapes toolbar) 

colored the desired yellow color. (Here‟s a video tutorial on how to do the half-circle in 

Illustrator.)  

 

 
 

 

To color it yellow, click on the “Select” tool, then click on the image of the circle. Now 

choose the desired color from the color panel on the far right hand side of the screen. 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=oneEhq82a6I
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THIRD BOTTOM LAYER: Outline of a tree - I used the pen tool to outline a tree 

from a random picture I found online. (There are tutorials for using the pen tool on page 

20.) 

 

 
 

You see how some of the tree is missing on the artboard? Initially the entire tree was 

there, but I thought it looked better with some of it missing. Kind of like a photograph.  

 

To achieve this look, I made a clipping mask over the artboard. This technique allowed 

me to cut away anything that‟s outside of the artboard, to make it look like the missing 

portions of the tree. 

 

Let me show you how you‟d do it with this oval hanging over the artboard. See how it‟s 

dangling out of the right and left of the artboard? We‟re going to mask the dangling 

parts.  
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First, you‟ll click on the “Shapes” toolbar and get the “Rectangle Tool.” 
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Now create a rectangle that fits exactly on the edges of the artboard. (Or as close as you 

can get.) To resize the rectangle, click on the “Select” tool and move the edges till you‟re 

happy. Keep in mind, everything outside of that new rectangle will get clipped off.  
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You‟ll need to select everything on the artboard that you want to clip. To do this, click on 

the “Select” tool. Now hold down the Shift key as you select all the objects you wish to 

clip.  

 

Since I want to get rid of the excess yellow box and the black oval, I click on both of 

these objects. Make sure the top rectangle stays selected as well. 
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Now go to the “Object” menu at the top of the program, go down to “Clipping Mask” and 

select “Make.”  

 

You should now see that the edges underneath the white rectangle have all been clipped 

away, as in the screenshot below. 

 

 
 

 

If you need to select any of the objects caught in the clipping mask, you‟ll now need to 

use the “Direct Selection” tool, which is the white arrow.  

 

That Direct Selection tool allows you to move either the black oval or the yellow 

background and still have the clipping mask cover the excess over the edges of the 

artboard. 

 

Neat, huh? Well that‟s exactly how I did the tree in the deer print.  
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FOURTH BOTTOM LAYER: White shadow of a deer - I used the pen tool to outline a 

deer from a random picture I found online. 
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FIFTH BOTTOM LAYER: Brown silhouette of a deer - This is a replica of the white 

shadow deer, except it‟s colored brown and it has a watercolor looking overlay. I moved 

it slightly to the right to give the illusion of a shadow.  

 

First, to make a copy of an image, use the “Selection” tool to highlight the image.  

 

 
 

 

Now go the "Edit" window at the top of the page, and scroll down to "Copy."  
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Once it has been copied, click outside of the canvas area to deselect the image. (Where 

the ugly red star is.) 

 

 
 

 

Now go the "Edit" window again at the top of the page, and go down to "Paste in Front." 
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 The copied image will now appear close to original image. 
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Now for the watercolor overlay on the deer.  

 

First, we‟ll find a watercolor texture that can be used specifically with Illustrator. Hello 

Geri has a nice looking freebie pack. (This isn‟t the one I used for the deer, but if you 

Google, “watercolor texture for Illustrator” you‟ll find many more available.) 

 

Once the texture file has been downloaded onto your hard drive, unzip it.  

 

Go to the “File” menu at the top of the program, and go down to “Place.”  

 

 
 

 

http://hellogeri.com/blog/view/watercolour_textures_pack
http://hellogeri.com/blog/view/watercolour_textures_pack
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It will open a file window, and you‟ll look for the watercolor texture (the same one you 

just downloaded and unzipped) that you want to use in your artwork. Once you see the 

one you want to use, double click it and it will appear in your Illustrator workspace. 
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Okay, right now that copied deer is underneath the watercolor texture. You need it to be 

over top of the watercolor texture.  

 

To do this, click on that “Selection” tool again and then click on the copied image of the 

deer. (You may have to click on the watercolor texture first to move it out the way a bit.) 
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Now right click on the deer you just selected. A window will pop up. You want to go 

down to “Arrange,” then “Bring to Front.” This will put the copied deer in front of the 

watercolor texture. (Make sure the deer is completely on the watercolor texture.) 

 

With the deer image still selected, you‟re going to hold the shift key while also clicking 

on the watercolor texture. This allows you to have both the watercolor texture and the 

deer image both selected at the same time. (Notice there are blue outlines around both 

objects.) 
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Go to the “Object” menu at the top of the program, click on it, go down to “Clipping 

Mask,” and click on “Make.”  
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The watercolor texture should have meshed with the image of the deer.  
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To add the brown color to the deer, keep it selected and click on the desired brown in 

the “Swatch” palette on the far left hand side of the screen. (If you don‟t see the swatch 

palette, click on the “Window” menu at the top of the program, and click on “Swatches.” 

It will then appear on the far left hand side of the screen.)  

 

You can also use the Color Picker (as described in the BOTTOM LAYER) to choose a 

color. The “Swatch” palette is just an alternative way to choose a color. 
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Move the brown deer over top of the white silhouette. Position it the way you want, and 

you‟re done! 
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One More Thing About Clipping Masks… 
 

The clipping mask technique can be used on both vector images and text. This means if 

you want to use glitter or gold foil texture on your text, you‟d use the exact same 

technique that I showed you for the brown deer.  

 

Place the text or the image over the texture… Select both the object and the texture with 

the “Select” tool… Go to the “Object” window at the top of the program, go down to 

“Clipping Mask” and click “Make.”  

 

If you need to undo the clipping mask at any time, use your mouse to right click on the 

image or text… a pop up window will appear… click on “Release Clipping Mask”… the 

mask will undo itself… the image/text and the texture will appear separately again.  
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Creating a Quote Print 
 

I‟ve got a really easy print quote formula that I follow and it‟s based on all the rules and 

guidelines I already provided you with.  

 

For this demonstration I‟m going to use a song called, Try Jah Love by Third World. 

(It‟s a reggae song from the early 80‟s, and Jah means God.) 

 

STEP 1: Create each word separately 

Select the “Type” tool in, and type in each word for your quote on a separate line. As you 

see in the screenshot here, I typed in „Try.‟  
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To enlarge the text, you‟ll click the “Select” tool (remember, it‟s that top black arrow at 

the top of the tools there). Now position your mouse over one of the corner anchor 

points… hold down your shift key… and drag it out. This technique maintains the sizing 

proportion of the word.  

 

Do the same thing for each word. The sizes don‟t have to match perfectly right now. 
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STEP 2: Choose your font 

To select a group of words, you‟ll click the “Select” tool and then while holding down the 

Shift key, click on each word.  
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Once all the words are selected, click on the “Type” menu at the top of the program, then 

go down to “Font” and hover your mouse over it.  

 

A list of fonts will appear for you to choose from. Pick the one you want and the words 

you‟ve chosen will change to that font selection. 
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I really like the Bebas font for typographic prints. It‟s clean, clear and simple. Right up 

my alley! 
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STEP 3: Re-size and adjust the words  

Now, I‟ll play with the sizing and the coloring of the words to see what I like. (I talked 

about re-sizing and coloring in the previous tutorial.) Since this is a reggae song, and the 

album cover has red, gold and green, I‟m going to use those colors for the words.  
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In this first version I used kerning to push the letters closer together in Try and Jah. 

This is something you‟ll be doing on a regular basis since the default setting for the 

character spacing may not give you the look you want.  

 

Go up to the “Window” menu at the top of the screen and go down to “Type,” then click 

on “Character.” The Character panel will pop up on the screen. The spot on the 

Character panel with the AV and the arrow underneath it is the kerning selector. 

 

Now using the “Select” tool, you‟ll click on the text that you want to push together (or 

move apart). For Try and Jah, I set the kerning to -75. For Love, I set it to -10. The 

higher the negative kerning, the less space in between each letter. For more space 

between each character, set it to a positive number. Easy. 
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In this second version, I set the kerning for Try and Jah at 200. (You can go higher than 

200 if you use the up arrow.) I left love at -10.  
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In this third version, I set the kerning to 300 for Try and Jah. Still at -10 for Love, except 

I did enlarge Love. I also separated the space in between the words.  

 

As you can see, it‟s all about playing with the text to see what you like.  

 

 
 

I like to run through a list of typographic options including: 

 Making each word a different color/Making one word a different color 

 Change the background color 

 Increase/decrease kerning 

 Increase/decrease space in between lines 

 Make a word bold, italic, a different font 

 Add a texture to a font 

 Make a word smaller or bigger than the rest 

 Make all the letters uppercase/lowercase 

 Slant a word/Turn a word upside down 
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STEP 4: Put in a background or elements (optional) 

As you can see outside the artboard, I have a few handmade elements to play around 

with, but I didn‟t like the way any of them looked. Instead, I changed the background 

colors.  
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And then I changed the font color for Jah. 

 

 
 

Now perhaps you would‟ve stopped by now. Or maybe you might‟ve kept going. It 

depends on the style you were working towards.  

 

There is no right or wrong answer here. It just depends on what you like. My guess is 

that if you liked the colored letters, most of your printables would consist of colored 

letters. Likewise if you liked the colored background, you‟d have a bunch of printables 

with striped, colored backgrounds.  

 

Typically once you find a style that you like, it‟s good to create a full line around that 

particular style. Make it your signature. Own it.  
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Listing Your Images on Etsy 
 

Getting 100 pieces of printable artwork done may seem like a big task, but it‟s just one 

half of setting up your shop. The second part comes with the listing process. 

 

Normally the listing part is a bit daunting. I run an earring shop on Etsy with 200+ 

listings and it was no easy feat getting all those pictures and descriptions done. I hated 

it! 

 

But with printables your job is MUCH easier because you don‟t have to take pictures of 

your work. Whoops… let me restate that. You have to take one picture -- total.  

 

That‟s one picture whether you have 100 listings or 1,000. This picture is going to be a 

demo to show how your work looks framed in real life -- just like I did with the deer 

print on page 28.  

 

Put your favorite print in a nice frame, with a matte. Notice how I photographed the 

deer print against a window background? Nothing fancy. The natural light was great 

because it really made the colors pop. Just do one demo picture like this and you‟ll be 

good to go. 

 

For all the others, you‟re going to use mockup scenes to display your work.  

 

What is a mockup scene, you ask? 

 

It‟s a pre-created image, like a desk, a table, wall space or a mantle. The mockup scene 

has a frame and all you have to do is insert your printable into the frame. You can then 

use this imagery in your Etsy shop listings, with no picture taking required.  

 

I love this one by Shop Lemony Fresh on Etsy. 

 

https://www.etsy.com/listing/228412915/styled-floral-stock-photography-image-on?ref=shop_home_active_5
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Mockup scenes do require Photoshop. And if you have Photoshop, each mockup maker 

has a tutorial for usage.  

 

However if you‟re not Photoshop proficient, do not despair. Since this is a one shot deal, 

you can always outsource this task to someone on Odesk or Elance. A friend of mine had 

100 images done for less than $30.  

 

Here are several more mockup scenes for your listing pleasure. As usual, do check the 

licensing to make sure that you can use these in your Etsy shop. As of right now, they‟re 

valid… but it‟s better to be safe than sorry. 

 

Creative Mockups 

They have several frame-on-desk mockups, plus a few larger frames.  

 

Shop Lemon Fresh 

Pretty, girly framed mockups.  

 

http://odesk.com/
http://elance.com/
https://www.etsy.com/shop/CreativeMockup
https://www.etsy.com/shop/shoplemonfresh?section_id=15487175&ref=shopsection_leftnav_2
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KL Styled Photographs 

If you‟re looking for a nursery scene, KL has a few to choose from. I also like the various 

sizes of the wall posters. Well worth a peek.  

 

Tany Di Design Studio 

I like the hanging mockups here. Very simple and uncluttered.  

 

Mockup Scene Creator Desk Edition 

Showcase your printable artwork in a poster frame on a desk scene that you create from 

a variety of elements. They have feminine items you can add, Christmas decorations, 

various types of chairs, plants, background images and so on. 

 

Create Your Own Mockups Extended License 

There are more than 200 elements you can include in the scene, like a laptop, watch, 

camera, sunglasses, etc.  

 

Gold Frame Desk Mockup 

This one has a gold frame against a pink and white wallpaper background. Nice and 

girly. 

 

White Vertical Frame Mockup 

Clean white frame with a plant in a can on a wooden floor. 

 

White Hart Design Studio 

They carry several frame mockup scenes that are clean and quite chic.  

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.etsy.com/shop/KLStyledPhotos
https://www.etsy.com/shop/TanyDiDesignStudio
https://creativemarket.com/Placeto/104565-Mockup-Scene-Creator-Desk-edition
https://creativemarket.com/DesignSurplus/169347-Extended-License
https://www.etsy.com/listing/196450277/gold-styled-frame-photoshop-mock-up?ref=shop_home_active_5
https://www.etsy.com/listing/207034012/styled-photograph-8x10-white-vertical?ref=related-1
https://www.etsy.com/shop/WhiteHartDesignCo
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9 Things You Must Include in Your Etsy Description 
 

The beauty of selling printable art is that what your customers sees is what they get. This 

means no creative descriptions are necessary, unless you just want to go above and 

beyond the call of duty.  

 

In general, there are 9 mentionables your Etsy descriptions should have. You can 

basically write one description and include it will all of your prints. The only thing you 

might want to customize at the beginning is the name of the print and the colors used. 

This allows you to get more SEO points.  

 

1) Keywords in the title 

There are three parts to the title of your listing. How you choose to incorporate these 

three parts is totally up to you. Just make sure they‟re all there for SEO purposes.  

 

The words “printable art” are a must. Mention the type of art it is – for example, kitchen 

art, nursery art, modern art, minimalist art, etc. And then tell what it is – motivational 

quote, Bible verse, clouds, butterflies, a deer.  

 

Here‟s an example: Deer in the Woods Printable Art, modern art, nursery art 

 

2) Tags 

Etsy permits a total of 13 tags. These are descriptive keywords/phrases based around the 

product you‟re selling.  

 

I always use the following 6 tags to start with: printable art, printable wall art, art print, 

digital art, digital print, instant download 

 

The remaining tags are devoted to colors, type of art – (nursery art, geometric art) and 

what‟s featured in the print (butterfly, light bulb). If I have the print listed as a set, I also 

like to use the term: art print set. 

 

3) Attention, attention… this is digital file.  

Somewhere in your description, clearly mention that customers will receive a digital 

download, NOT a print in the mail. Even though you say „printable,‟ you never want 

there to be any type of misunderstanding.  
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4) Sizing details about the print 

Mention the size of the jpegs they‟ll receive. Several sellers include more than one size 

(8x10 and 11x14) within a single listing. If you‟re willing to do this, it could be a 

noticeable selling point.  

 

5) A list of other prints in your inventory that would match as a set 

If you have a group of 2-4 prints that would look good together, do cross-sell them 

(include links to them) in your description. Even in my earring shop, my biggest sellers 

are the groups I put together.  

 

6) How and where to print 

Most prints will look the best when printed through digital photo sites like Snapfish or 

Shutterfly. I‟ve also used FedEx Kinko‟s, which is good because customers can choose 

the paper type they want. I find that a crisp white cardstock usually works best.  

 

7) Colors vary according to monitor  

Every monitor is calibrated differently, so colors that appear one way on my system may 

look slightly different on yours. You can keep your customers expectations in check by 

saying something like, “Please be aware that every monitor is different, so the color you 

see on the screen may look slightly different when printed out.”  

 

8) Where’s the link? 

Minutes after your customer orders, they‟ll receive an email with a link to the printable. 

Mention this in the description so they know what to expect.  

 

9) Terms of use 

You may use this in your listing: “STORE NAME prints are for personal use only. They 

cannot be resold or redistributed either in print or electronically. They cannot be used 

for commercial or promotional ventures.”  
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Marketing Your Printables on Etsy 
 

I don‟t do marketing outside of Etsy.  

 

That‟s not to say that my work isn‟t promoted outside of Etsy. It just means that I don‟t 

do the leg work. If your art is worth sharing, trust and believe that people will spread the 

word on their blogs and sites like Pinterest.  

 

But that‟s just it. It has to be share-worthy. It needs to have a defined audience and the 

design work has to be decent.  

 

I made up a store idea on page 12 called Get Outside Child. This is the kind of shop that 

would get some decent off-of-Etsy attention. Why? Because there are a lot of parents 

who think kids spend too much time playing video games and watching television.  

 

A shop like Get Outside Child would appeal to many mom bloggers with this philosophy. 

Best of all, they‟re ALWAYS looking for cute stuff like this to feature.  

 

Years ago I ran a blog where I reviewed hipster type products on Etsy. I counted the 

clicks that went out to the products I reviewed and the numbers were quite astounding. 

I don‟t know the exact sales figures, but I did notice that often a product would show up 

as „sold‟ after it appeared on my blog.  

 

To get other people to market your printables, you have to focus on doing awesome 

design work and selling to a defined audience. If you do those two things, the sales often 

fall into place.  

 

Here‟s a list of marketing tasks I do. Though Etsy changes its search algorithms 

periodically, these are the things that have consistently kept me in front of potential 

buyers no matter what else is going on.  

 

Relist at least 3-5 items EVERY DAY 

It‟ll cost you 20¢ each time, but this is probably the most important on-site marketing 

task you can do.  

 

When you re-list an item it pushes it to the front of the category results. This means 

potential buyers are more apt to see your item if they‟re browsing through the art 

category at the time you re-list.  
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I suggest you try re-listing at different times during the day to see when you get the most 

eyeballs. For me, it‟s usually after 2pm EST, but results may vary for you.  

  

Create a Treasury 4 times a week 

The Treasury is a huge set of member-curated galleries consisting of items on Etsy. You 

can include a maximum of 16 items in each Treasury, and you can create as many 

Treasuries as you want. (Etsy suggests you choose items from different shops, versus 

listing several items from a single shop.) 

 

If you happen to curate a really good Treasury, the number of views can be astounding. 

It‟s possible to get 5-8K+ views in an eight hour period. This isn‟t the norm, but it is 

possible. Most Treasuries get about 30-100 views on the first day, and then the views 

trickle in from there. Of course, the more Treasuries you build, the better your chances 

for hitting the big time.  

 

When you curate a Treasury, you can include a list of tags in submission. Always make 

sure to include tags listed in the “Today‟s Trending Tags” section of the Treasury page.  

 

 
 

 

In fact, if you click on any of the tags in the “Today‟s Trending Tags” section, you‟ll be 

shown several more related tags. This is an easy way to get in on the most trafficked 

terms for the day.  

 

https://www.etsy.com/treasury/?ref=fp_nav_treasury
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But don‟t limit yourself to just these tags. Right now “may shopping” is trending, but you 

can also try “spring 2015” and “spring shopping” as tags.  

 

Also, the first 4 items of every Treasury is shown on the Treasury page. So be sure your 

printable is within that rotation, plus 3 other stunning items. You want the best of the 

best within those first 4.  

 

Re-color and list 5-10 items a week 

Even though I‟ve been at this for several years, I‟m often a bit amazed at what people 

end up buying.  

 

Sometimes the things I think will sell like crazy, only do okay, while the stuff I really 

don‟t like ends up doing seriously well. And then you have situations where people will 

„like‟ something to death, but nobody buys it. But the items that nobody „likes,‟ ends up 

selling like crazy.  

 

That seems to be the case with colors. 

 

I learned a long time ago that it‟s best to offer a printable in a variety of colors and let 

the customers decide, versus trying to figure out what‟s going to sell. (This is the beauty 

of a 20¢ listing selling a printable. You can afford to test on a serious shoestring because 

you‟re not printing anything out and there are no pictures to take.) 

 

Although Etsy allows you to have multiple color options within a single 20¢ listing, I 

prefer to have separate listings for each color.  

 

It‟s better for SEO purposes if you can devote all of your tags to a single focus. Plus, it 

makes your shop appear bigger, which definitely encourages deep browsing.  

 

Earlier I mentioned that I go to the library and scan through the home decorating 

magazines to see what‟s new with wall ware. Well I also use those magazines to see what 

colors are hot.  

 

Promoted listings 

I have been using promoted listings for all of my Etsy shops, and yes, I do see a good 

return on my investment.  

 

A promoted listing is an ad that appears above the rest of the listings in a category AND 

within the search results. They appear on each category or search page, not just the first 

one. 
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As you can see from the screenshot below, there is a small tag marked “Ad” on the 

promoted listings.  

 

 
 

 

Promoted listings work just like a pay per click ads in that you only pay for the click 

throughs to your Etsy shop. You decide on how much you want to pay per click.  

 

You can choose which printables to feature as a promoted listing, or new items will 

automatically be put into the promoted listing rotation.  

 

Etsy has a basic analytics setup, allowing you to see: 

 Number of impressions 

 Number of clicks 

 Cost for clicks received 

 Direct sales revenue (customer ordered the product featured in the promoted 

listing) 

 Indirect sales revenue (customer ordered a different product than the one 

featured in the promoted listing) 
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For my smaller shops, I‟ve always chosen to feature the listings that have received the 

most orders.  

 

But with a bigger shop (over 100 items to start) it‟s best to let all of the items rotate until 

you see which ones receive the most likes or sales.  

 

And if you have printables that match with specific holiday seasons (like hearts for 

Valentine‟s Day), you‟ll definitely want to pause the others, and push the seasonal items.  

 

3 Ways to Make the Most of Promoted Listings has some additional bidding tips to help 

you.  

 

Etsy Promoted Listings: How I Turned $600 into $3000 shows you why you must think 

long-term with promoted listings.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.etsy.com/seller-handbook/article/3-ways-to-make-the-most-of-promoted/22423534249
http://www.handmadeology.com/etsy-promoted-listings-how-i-turned-600-into-3000/
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Must See Tutorials 
 

While I‟ve given you the bare minimum basics to help you get your store up and 

running, these tutorials will guide you into the intermediate zone.  

 

Illustrator CC tutorials from novice to expert 

These are presented directly from Adobe. You can start off learning the basics with short 

videos, and then move on to more advanced techniques. This is a great collection for 

filling in the gaps.  

 

Creators Couture YouTube Channel 

Jessica will show you how to add some serious glam (gold, shimmering goodness) to 

your fonts and images.  

 

How To Create Typography Illustrations the Easy Way 

This one shows you how to use the pen tool, a photographic background and typography 

in one sitting. Definitely one of my favorites.  

 

How to Create a Simple Typographic Poster Design 

All kinds of font changing ideas here.  

 

How to Create a Line Art Minimal Designer‟s Stamp in Adobe Illustrator 

This tutorial will show you how to use many of Illustrators features to create a simple 

piece of art.  

 

Case study: How a 22-year old made $28,139 on Etsy 

While this guy doesn‟t sell printables, he does sell posters. And even better, he co-signs 

on the concept of cross-selling.  

 

 

 

 

 

 

 

 

 

 

 

 

https://helpx.adobe.com/illustrator/tutorials.html
https://www.youtube.com/channel/UCctAPKnu8C4S5nQWIIVtS1Q
http://blog.spoongraphics.co.uk/tutorials/how-to-create-typography-illustrations-the-easy-way
http://ditscheri.com/blog/how-to-create-a-simple-typographic-poster-design
http://design.tutsplus.com/tutorials/how-to-create-a-line-art-minimal-designers-stamp-in-adobe-illustrator--cms-22906
http://www.iwillteachyoutoberich.com/blog/case-study-how-a-22-year-old-made-28139-on-etsy/
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10 Printables Critique Voucher 
 

 

Submit up to 10 of your printables for a full critique 

review.  

 

Submit all 10 at once, or one at a time.  

 

Email to: 

mailto:constructincolor@gmail.com?subject=Printables 

Critique 

 
 

 

mailto:constructincolor@gmail.com?subject=Printables%20Critique
mailto:constructincolor@gmail.com?subject=Printables%20Critique

